
3 A LogXact Tutorial

We believe you will enjoy analyzing data using LogXact. One reason is of course that it
performs exact inference. A second reason is its user interface. You can enter, view, or alter
data, build models, and browse through the output in a friendly interactive environment. You
will find this very convenient even if you use LogXact only for asymptotic inference.

The easiest way to learn LogXact is to sit at the computer and analyze a data set. This tutorial
will take you through such a hands-on analysis quickly. In the process, you will become
familiar with several of LogXact’s important commands, and will gain an overall
understanding of how they all work together. The subsequent chapters will build on your
experience by providing more details about the individual commands, a broader variety of
examples, technical details about the output, and some discussion of the theory behind exact
logistic regression.

This tutorial also explains with an Example, a very useful feature available in LogXact,
namely, batch lanuage commands. Using this feature, you can create a single batch
command file containing commands for several different analyses on one or more data sets.
This command file can be submitted in LogXact for execution without you having to wait at
the computer.

3.1 Activating LogXact Before you begin this tutorial:

1. Verify that LogXact is properly installed in a separate directory on your hard disk.
2. Verify the name of the directory in which all the sample data sets, supplied as part of

the LogXact software, are stored.

This tutorial will assume that you have installed LogXact in C:\LOGXACT and have stored
the LogXact data sets in C:\LOGXACT\DATA. Make appropriate modifications to the
tutorial instructions if either LogXact or the data sets are stored in other directories.

3.2 Bringing Data into
LogXact

3.2.0 Data Description
3.2.0 Opening a LogXact

File
3.2.0 Examining

Ungrouped Data
Converting to Group Data

Data may be entered into LogXact as case data or as group data, read in as a previously
saved LogXact file through the Open command in the File menu, or read in from another
software package through the Import command. In this tutorial, you will read in a
previously saved data file using the Open command.

Description of the Data Set
We are grateful to Dr. S. Lai, University of Miami, for providing this example. A hospital
based prospective study of perinatal infection and human immunodeficiency virus (HIV- 1)
by Hutto, Parks, Lai, et al. (1991) investigated the possibility that the CD4 and CD8 blood
serum levels measured in infants at 6 months of age might be good predictors of eventual
HIV infection. The data on HIV infection rates and blood serum levels are tabulated below:
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Proportion Developing Serum Levels at 6 Months
HIV CD4 CD8
4/7 (57%) 0 0
1/1 (100%) 0 2
2/7 (29%) 1 0
4/12 (33%) 1 1
2/2 (100%) 1 2
0/2 (0%) 2 0
0/13 (0%) 2 1
1/3 (33%) 2 2

The above data set is one of several that are supplied along with your LogXact software. It is
stored in a file named HIV.CYD. If you followed the installation procedure exactly as
described in the Chapter titled “Installation" in Cytel Studio manual, you should have this
and all other data sets saved in a separate DATA subdirectory of your LogXact directory on
your hard disk.

Opening a LogXact Data File
One of the data sets in the DATA subdirectory is a file named HIV.CYD. To open this file in
LogXact, choose from the main menu:

File
Open . . .

In the ensuing dialog box, select the file HIV.CYD in the DATA subdirectory, and click OK .
Notice that a new workbook is created and data are brought into the “HIV.CYD"
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The HIV.CYD file is brought into LogXact and the data window appears as follows:

The name of the file just opened (HIV.CYD) appears at the top of the data window.

Examining Ungrouped Case Data in the Data Editor
The case data are now in the Data Editor where you can examine and possibly edit the
HIV.CYD data.

Use the mouse or the ↑ ↓ → ← arrow keys to move the cursor around in the worksheet
and examine more of the data records. You can easily alter the data by typing in a new entry
at the current position of the cursor. However, please do not alter the data permanently as
they are needed in their original form for this example.

Converting to Group Data
In this data set, the binary HIV variable (1=yes, 0=no) is the response variable. The variable
named FREQ gives the weight or frequency count, of the number of records with the same
values of HIV, CD4 and CD8. For example, the second record displayed by the Data
Editor had a weight of 2 (FREQ=2 for that record), implying that it will be treated as
equivalent to two records, each having HIV=1, CD4=1, and CD8=2. The data are
ungrouped. This means that we did not gather together records with the same covariate
values. However, we might get a better feel for the data if they were first converted to
grouped format. Choose from the menu:

DataEditor
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Convert to Group Data . . .

In the ensuing dialog box, select HIV as the Response variable and FREQ as the Weight
variable. The dialog box now looks as shown below.

Click on OK .

On conversion, LogXact takes you to a new Data Editor window.

To explain the above grouped form of the data, let us look at the first record: HIV=4,
FREQ=7, Resp(%)=57.14%, CD4=0 and CD8=0. What this means is that there were 7 cases
having covariate values as CD4=0 and CD8=0 and out of which in 4 cases, the response
variable HIV had the value of 1 and in the remaining 3 cases, HIV took the value of 0. So the
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response % for these 7 cases is 57.14% (= (4/7)X100). The grouped form makes it a little
easier to see how the covariates affect the response rate. It is also easier to enter small data
sets into LogXact in grouped form, since that is how they usually appear in journal articles.
Indeed that is the way the data were presented at the start of this section.

3.3 Saving Your Data
As a LogXact file

It is usually a good idea to save your data set after you have worked on it. LogXact allows
you to save the current data set (if it is case data) in LogXact or Text data file format. If the
current data set is in grouped data format, then you can save it only in LogXact grouped data
file format.

As a LogXact file
Suppose you wish to save the current grouped data set in LogXact file format. Choose from
the menu:

File
Save As

This brings up the following dialog box:

Enter the file name as HIV Group and click on Save. Now the file HIV Group will be
saved in the DATA subdirectory. Notice that the .CYD extension is the default extension
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assigned to the file name. You can override the default by specifying another extension
explicitly.

3.4 Model Specification,
Estimation and
Testing

Model Specification
Parameter Estimation
3.4.1 Factor Variables
Maximum Likelihood Can

Fail
Exact Estimates Exist
3.4.1 Testing Parameter

Subsets
3.4.2 Exploration Mode
Obtainable Output

The directions in this section will take you through the steps of building a binary logistic
regression model, estimating its parameters, and performing hypothesis tests. The technical
details of the maximum likelihood and conditional inference procedures underlying these
steps, are provided in Appendix A. You may skip Appendix A for the present, since the goal
of this tutorial is to gain a quick understanding of how LogXact works without being
overwhelmed by technical details.

To fit a logistic regression model, choose from the menu:

Regression
Binary Response
Logistic Model . . .
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This brings up the following Binary Regression: Logistic Model dialog box:

In the dialog box, notice that HIV is the Response variable, and FREQ is the Groupsize
variable, reflecting the choices you made in converting to grouped data. Also notice that
%Const is shown as a model term. This is because LogXact, by default always fits a model
which includes the constant term unless you uncheck the box shown against “Include
intercept term" or you are fitting a conditional logistic regression model (See Chapter 8 for
details on conditional logistic regression.).

Model Specification
Select Model Terms to specify an appropriate model. To begin with, model the HIV
response rate as a function of CD4 and CD8, both covariates being regarded as ordinal. In
the Binary Logistic Regression dialog box, select CD4 and CD8 as the Model
Terms. The variables CD4 and CD8 should now appear in the Model Terms section of
the Binary Logistic Regression dialog box.
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Parameter Estimation
Estimate the regression coefficients by clicking on the OK button, accepting the Estimate
and Asymptotic defaults in the dialog box. The maximum likelihood estimates,
asymptotic p-values and asymptotic confidence intervals for the regression parameters are
computed and displayed in the Binary Regression (As) - Estimate worksheet
of the workbook, as shown below:

The Binary Regression worksheet in the workbook enables you to view all the
regression estimates during the current model-fit. If you leave this worksheet, you can
always return to it. The results of fitting the model are displayed in three sections. (See
Section 5.2 for details on the contents of this worksheet.)

The first section, titled “Basic Information”, gives the filename of the data used to fit the
model; specifies the model; shows the group size variable used, if any; specifies the stratum,
if any; and describes the type of analysis performed, gives the number of model terms, the
number of terms dropped, the number of observations, and the number of distinct groups (or
covariate combinations that can be formed by the covariates in the current model).

The second section, titled “Summary Statistics”, gives the value of the deviance and the value
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of the likelihood ratio statistic, the corresponding degrees of freedom, and the p- value for
testing the overall significance of the model, i.e., for testing the null hypothesis that all the
model parameters (including the constant term) are zero.

The third section, titled “Parameter Estimates” contains output relating to the terms in your
model. Here, you can examine point estimates and their standard errors, asymptotic
confidence intervals, and p-values for the regression coefficients corresponding to CD4,
CD8, and the constant term.

Suppose you wish to estimate the regression coefficients using the exact method. Simply
choose the Exact option in the Binary Regression: Logistic Model dialog
box and click on OK.

The Work In Progress display box will appear as shown below.
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There is a section containing three progress meters at the top of the Work In Progress
box. Immediately above the first progress meter, there is a line that tells you what job is
being performed. In this example, it is “Estimating [CD4]”, the current model term.

The Elapsed time progress meter indicates how much of the maximum computation time has
elapsed while estimating the current model term. The time displayed is incremented at
regular intervals of at least 5 seconds.

The Max. memory used progress meter indicates how much of the maximum available
memory has been consumed while estimating the current model term.

The Percentage of job done progress meter indicates how much of the current job has been
completed.

Since this is a small data set, the execution of the job will be very fast and the Work In
Progress message box may not remain on the screen for long for you to see it properly.
But while analysising larger data sets, you will be able to see properly the message box and
the information it diplays on the the continuous monitoring of the job.

(See Section 9.2.3 for more details on the Work In Progress message box.)

After some time, the results appear in Binary Regression (EX) worksheet as shown below.

Notice that the asymptotic and exact estimation methods can lead to different conclusions.
For example the exact p-value for CD4 is about six times smaller than the asymptotic
p-value. Again, CD8 is statistically significant at the 5% level asymptotically, but not by the
exact method.
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Sometimes, exact estimation may take too much computation time. In such situations, it is
advisable to use Monte Carlo estimation instead. To do this, simply choose the Monte
Carlo option in the Binary Regression: Logistic Model dialog box and click
on OK.

The Work In Progress display box will appear at first. After some time, the Monte
Carlo estimates will appear in the worksheet Binary Regression (MO) as shown
below.

3.4.1 Factor Variables
In this data set, CD4 and CD8 assume the values 0,1,2. But these are not the actual blood
serum levels. Rather they are coded surrogates for them. Thus suppose you are unwilling to
treat CD4 and CD8 as ordinal variables, but would like to treat them as factors. This requires
that CD4 and CD8 each be split up into two dummy variables. The Toggle Factor
option in the Binary Logistic Regression dialog box accomplishes this splitting.
You may choose as the baseline for the splitting either the highest value or the lowest value of
the variable being split, by editing the variable properties in the data editor window. The
default takes the highest value as the baseline. Choose from the menu:

Regression
Binary Response
Logistic Model . . .

Select CD4 and CD8. Then, click on the Toggle Factor On/Off button under the list
of variables. Notice that the Model Terms section of the window shows <fa> next to both
CD4 and CD8. This means that CD4 has been split into two dummy variables, CD4 0 and
CD4 1. The CD4 0 variable assumes the value 1 when CD4 is 0, and assumes the value 0
otherwise. The CD4 1 variable assumes the value 1 when CD4 is 1 and 0 otherwise. CD8
has been similarly split.
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The Toggle Factor on/off button toggles the factor variables on or off. If you want
to restore the factor variables as ordinal variables, click on this button again. Sometimes, a
variable could have been declared as factor variable in the editor. In that case, <fa> will
appear next to the factor variable. You can click on Toggle Factor on/off to use the
variable as ordinal variable in the current model.

Maximum Likelihood Can Fail
With CD4 and CD8 declared as factor variables, try to obtain the unconditional maximum
likelihood estimates of the regression coefficients for the model HIV=CD4+CD8 by selecting
Asymptotic and then clicking on the OK button.

Because the maximum likelihood estimates do not exist for this small data set, convergence
is not possible in this case. The Results window contains only question marks for all the
model terms.

This is not a problem in LogXact alone. You will face the same difficulty with any other
logistic regression software: SAS, BMDP, GLIM or Egret. Appendix F explains why the
maximum likelihood method fails in some situations.
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Exact Estimates Exist
We saw previously that CD4 and CD8 are statistically significant when treated as ordinal
variables. Unfortunately, the unconditional maximum likelihood method failed when these
two variables were treated as factors. Is there any other way to assess the significance of CD4
and CD8 when they are factor variables? There is! The exact conditional approach
(discussed in Appendix A) comes to our rescue here. Choose from the menu:

Regression
Binary Response
Logistic Model . . .

Then select the Exact option, and click OK in the ensuing dialog box.

At first, the Work In Progress box appears. After some time, the following Results
window appears:

Now notice that exact point estimates, confidence intervals, and p-values do exist even
though the asymptotic ones do not. In the Results window, you can also see the estimates
for the CD8 0 and CD8 1 dummy variables. If you wish to see the output of the previous
model, you can go to the Log window and scroll up through it.

Testing Subsets of Regression Parameters
The p-values displayed for the CD4 and CD8 variables, while statistically significant, are not
very helpful. These p-values only apply to each dummy variable separately. Thus you know
that CD4 0 has a p-value of 0.0145 and CD4 1 has a p-value of 0.0127. But you would really
like to perform a multiple hypothesis test that

CD4 0 = CD4 1 = 0

Three commonly used asymptotic methods for testing that a subset of the regression
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parameters are zero are the likelihood ratio test, the Wald test, and the asymptotic
unconditional score test. The Test option computes all three tests. Choose from the menu:

Regression
Binary Response
Logistic Model . . .

Click on the Test option in the ensuing dialog box. Use the Toggle Selected for
Testing Yes/No button to select CD4 as the model term to test. Choose the
Asymptotic option and click OK to run the test. The results of the Test are displayed in
the Results window. Of course in the present case since the unconditional maximum
likelihood method has failed, only the asymptotic unconditional score test can be computed,
for it does not require the full model to be estimated. (See Appendix A, page 445, for
details). The unconditional score test yields a p-value of 0.0063.

Now, suppose you want to use the Monte Carlo method. Choose the Test and Monte
Carlo options in the Binary Logistic Regression dialog box. The Test
worksheet of the Results window is shown below:

Once again invoke the exact option by selecting the Test and Exact options in the
Binary Logistic Regression dialog box. The exact conditional scores test, based
on the joint distribution of the sufficient statistics for CD4 0 and CD4 1, provides a p-value
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of 0.0071, in good agreement with the asymptotic unconditional score test.

Choose from the menu,

Regression
Binary Response
Logistic Model . . .

In the ensuing dialog box use the Toggle Selected for Testing Yes/No button
to select CD8 and to deselect CD4 for testing. You will see that the exact conditional score
test that

CD8 0 =CD8 1=0

yields a p-value of 0.0256, whereas the asymptotic unconditional score test yields a p- value
of 0.0198.

3.4.2 Exploration Mode
Exploration mode is an advanced feature of LogXact for logistic regression using
Monte Carlo estimation or testing. It enables you to interactively improve the network
sampling time. For details see Chapter 10.

Obtainable Output
The information on what output items are obtainable under different types of analysis is
given in Appendix H.

3.5 The LogXact
Command Language

Command Bar
Submit Command File

In LogXact, commands can be issued in three different ways: by invoking the menus, by
typing them in the command bar, or by submitting a batch file. The command bar and batch
command files use the LogXact Command Language, whose syntax is described
comprehensively in Appendix J.

Command Bar
Suppose you want to perform the following sequence of tasks in LogXact:
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1. Open the HIV.CYD file
2. Make HIV the response variable
3. Make FREQ the weight variable
4. Declare variable CD4 to be a factor variable
5. Specify the model
6. Estimate the model parameters

Previously in this chapter, you have seen how to accomplish such actions through the menus
and dialog boxes. Instead of using the menus, you can type and execute one command at a
time in the command bar located at the bottom of the LogXact window. To open HIV.CYD
from the default data file path (if it had been already defined through the menu item
Options-File Paths), type the following in the command bar: US HIV.CYD .
Alternatively you can type in the full file path as in the following example:

US C:\LOGXACT\DATA\HIV.CYD

Press Enter . The HIV.CYD dataset appears in the Data Editor as shown below.

To specify that you are going to fit Binary Logistic Model enter in the command
bar: LX LOGIT.
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To specify HIV as the response variable, enter in the command bar: LX RE HIV.
To specify FREQ as the weight variable, enter in the command bar: LX WE FREQ.
To declare CD4 as a factor variable, enter in the command bar: LX FA CD4.
To specify the model, enter in the command bar: LX MO %Const + CD4 + CD8.
To estimate the model parameters, enter in the command bar: LX ES AS %Const CD4

CD8.

Now the results will appear as shown below.

Submit Command File
The Submit item in the Edit menu is used to run batch jobs, using LogXact’s Command
Language. It processes a series of LogXact commands located in an externally created batch
file. Such a file is created in LogXact by specifying Submit (Command) File after
choosing the New item on the File menu, or by copying the contents of the History of
commands file.

A batch file for the previous example might consist of the following LogXact commands,
listed one below the other. (Command lines having the first character as “!" are taken to be
comment lines and they are ignored by LogXact):
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! A sample batch file
US HIV.CYD
LX LOGIT
LX RE HIV
LX WE FREQ
LX FA CD4
LX MO %Const + CD4 + CD8
LX ES AS %Const CD4 CD8

Suppose the file containing the above sequence of LogXact commands is called
BATCHRUN.CMD. Then choose from the menu:

File
Open . . .

Select .CMD as the filetype. Then select BATCHRUN.CMD as the file to submit in the ensuing
dialog box. Now choose from the menu:

Edit
Submit . . .

LogXact immediately begins processing the commands, one at a time and the results will
appear as before.

This example illustrates how to run a time-consuming series of jobs without having to wait at
the computer. (Jobs can, for example, be run overnight with output redirected to files.)

3.6 Getting On-Line Help The Help command provides on-line help for all the LogXact commands. To activate the
on-line help choose from the menu:

Help
Help Topics
LogXact

To access the online user manual in pdf format click on

Help
Online User Manuals
LogXact

3.7 Exit To exit the current LogXact session entirely, choose from the menu:

File
Exit
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You will be prompted about unsaved items
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